Chapter 375

Ratio of Polynomials
Fit – One Variable

Introduction

This program fits a model that is the ratio of two polynomials of up to fifth order. Examples of this type of model are:

\[ Y = \frac{A_0 + A_1 X + A_2 X^2}{1 + B_1 X + B_2 X^2} \]

and

\[ Y = \frac{A_0 + A_1 X + A_2 X^2 + A_3 X^3 + A_4 X^4 + A_5 X^5}{1 + B_1 X + B_2 X^2 + B_3 X^3 + B_4 X^4 + B_5 X^5} \]

These models approximate many different curves. They offer a much wider variety of curves than the usual polynomial models. Since these are approximating curves and have no physical interpretation, care must be taken outside the range of the data. You must study the resulting model graphically to determine that the model behaves properly between data points.

Usually you would use the Ratio of Polynomials Search procedure first to find an appropriate model and then fit that model with this program.

Starting Values

Starting values are determined by the program. You do not have to supply starting values.

Assumptions and Limitations

Usually, nonlinear regression is used to estimate the parameters in a nonlinear model without performing hypothesis tests. In this case, the usual assumption about the normality of the residuals is not needed. Instead, the main assumption needed is that the data may be well represented by the model.

Data Structure

The data are entered in two variables: one dependent variable and one independent variable.
Missing Values

Rows with missing values in the variables being analyzed are ignored in the calculations. When only the value of the dependent variable is missing, predicted values are generated.

Procedure Options

This section describes the options available in this procedure.

Variables Tab

This panel specifies the variables used in the analysis.

Variables

Y (Dependent) Variable
Specifies a single dependent (Y) variable from the current database.

Y Transformation
Specifies a power transformation of the dependent variable. Available transformations are $Y' = 1/(Y^2)$, $Y = 1/Y$, $Y' = 1/SQRT(Y)$, $Y' = LN(Y)$, $Y' = 1/SQRT(Y)$, $Y' = Y$ (none), and $Y' = Y\cdot Y$

X (Independent) Variable
Specifies a single independent (X) variable from the current database.

X Transformation
Specifies a power transformation of the independent variable. Available transformations are $X' = 1/(X^2)$, $X' = 1/X$, $X' = 1/SQRT(X)$, $X' = LN(X)$, $X' = 1/SQRT(X)$, $X' = X$ (none), and $X' = X\cdot X$

Model

Bias Correction
This option controls whether a bias-correction factor is applied when the dependent variable has been transformed. Check it to correct the predicted values for the transformation bias. Uncheck it to leave the predicted values unchanged. See the Introduction to Curve Fitting chapter for a discussion of the amount of bias and the bias correction procedures used.

These options specify the polynomials as well as certain values used to control the convergence of the nonlinear fitting algorithm.

Model – Numerator and Denominator Terms

Numerator and Denominator Terms (A1 X^1 ... B5 X^5)
These options specify which terms are in the model. The A-terms refer to the numerator and the B-terms refer to the denominator. Note that X^3 means X*X*X (X cubed).

Hence, checking A1 X^1, A2 X^2, B1 X^1, and B2 X^2 specifies the polynomial ratio model:

$$Y = \frac{A0 + A1X + A2X^2}{1 + B1X + B2X^2}$$
Note that the constant term, $A_0$, is always included in the model.

We encourage you to follow a hierarchical approach to model building which is that you never fit a term without fitting all terms of lesser order. Hence, if you include $A_3$ in your model, you also include $A_1$ and $A_2$. Also, never fit a higher order in the numerator than in the denominator. You can fit a higher order polynomial in the denominator than in the numerator.

If you follow these simple rules, you will usually be happy with the performance of your models.

**Options Tab**

The following options control the nonlinear regression algorithm.

**Options**

**Lambda**

This is the starting value of the lambda parameter as defined in Marquardt’s procedure. We recommend that you do not change this value unless you are very familiar with both your model and the Marquardt nonlinear regression procedure. Changing this value will influence the speed at which the algorithm converges.

**Nash Phi**

Nash supplies a factor he calls $\phi$ for modifying lambda. When the residual sum of squares is large, increasing this value may speed convergence.

**Lambda Inc**

This is a factor used for increasing lambda when necessary. It influences the rate at which the algorithm converges.

**Lambda Dec**

This is a factor used for decreasing lambda when necessary. It also influences the rate at which the algorithm converges.

**Max Iterations**

This sets the maximum number of iterations before the program aborts. If the starting values you have supplied are not appropriate or the model does not fit the data, the algorithm may diverge. Setting this value to an appropriate number (say 50) causes the algorithm to abort after this many iterations.

**Zero**

This is the value used as zero by the nonlinear algorithm. Because of rounding error, values lower than this value are reset to zero. If unexpected results are obtained, you might try using a smaller value, such as $1E-16$. Note that $1E-5$ is an abbreviation for the number 0.00001.

**Reports Tab**

The following options control which reports and plots are displayed.

**Select Reports**

**Iteration Report ... Residual Report**

These options specify which reports are displayed.
Report Options

Alpha Level
The value of alpha for the asymptotic confidence limits of the parameter estimates and predicted values. Usually, this number will range from 0.1 to 0.001. A common choice for alpha is 0.05, but this value is a legacy from the age before computers when only printed tables were available. You should determine a value appropriate for your needs.

Precision
Specify the precision of numbers in the report. Single precision will display seven-place accuracy, while the double precision will display thirteen-place accuracy. Note that all reports are formatted for single precision only.

Variable Names
Specify whether to use variable names or (the longer) variable labels in report headings.

Plots Tab
This section controls the plot(s) showing the data with the fitted function line as well as the residual plots.

Select Plots
Function Plot with Actual Y ... Probability Plot with Transformed Y
These options specify which plots are displayed. Click the plot format button to change the plot settings.

Storage Tab
The predicted values and residuals may be stored to the current dataset for further analysis. This group of options lets you designate which statistics (if any) should be stored and which variables should receive these statistics. The selected statistics are automatically stored to the current dataset while the program is executing.

Note that existing data is replaced. Be careful that you do not specify columns that contain important data.

Storage Columns
Store Predicted Values, Residuals, Lower Prediction Limit, and Upper Prediction Limit
The predicted (Yhat) values, residuals (Y-Yhat), lower 100(1-alpha) prediction limits, and upper 100(1-alpha) prediction limits may be stored in the columns specified here.
Example 1 – Fitting a Ratio of Polynomials Model

This section presents an example of how to fit a ratio of polynomials model. In this example, we will fit a third order polynomial in the numerator and a fourth order polynomial in the denominator to the variables Y and X of the FnReg3 database.

You may follow along here by making the appropriate entries or load the completed template Example 1 by clicking on Open Example Template from the File menu of the Ratio of Polynomials Fit – One Variable window.

1 Open the FnReg3 dataset.
   • From the File menu of the NCSS Data window, select Open Example Data.
   • Click on the file FnReg3.NCSS.
   • Click Open.

2 Open the Ratio of Polynomials Fit – One Variable window.
   • Using the Analysis menu or the Procedure Navigator, find and select the Ratio of Polynomials Fit – One Variable procedure.
   • On the menus, select File, then New Template. This will fill the procedure with the default template.

3 Specify the variables.
   • On the Ratio of Polynomials Fit – One Variable window, select the Variables tab.
   • Double-click in the Y (Dependent) Variable box. This will bring up the variable selection window.
   • Select Y from the list of variables and then click Ok.
   • Double-click in the X (Independent) Variable box. This will bring up the variable selection window.
   • Select X from the list of variables and then click Ok.
   • Under the Numerator Terms heading, check A1 X^1, A2 X^2, and A3 X^3.
   • Under the Denominator Terms heading, check B1 X^1, B2 X^2, B3 X^3, and B4 X^4.

4 Specify the options.
   • On the Ratio of Polynomials Fit – One Variable window, select the Options tab.
   • Enter 10 in the Max Iterations box.

5 Specify the reports.
   • On the Ratio of Polynomials Fit – One Variable window, select the Reports tab.
   • Check the Residual Report box. Leave all other reports and plots checked.

6 Run the procedure.
   • From the Run menu, select Run Procedure. Alternatively, just click the green Run button.
## Minimization Phase Section

<table>
<thead>
<tr>
<th>Itn No</th>
<th>Error Sum Lambda</th>
<th>Lambda A0</th>
<th>A1</th>
<th>A2</th>
<th>A3</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>70.81162</td>
<td>0.00004</td>
<td>11.78766</td>
<td>-0.2798519</td>
<td>5.809555E-03</td>
</tr>
<tr>
<td>1</td>
<td>70.73225</td>
<td>0.16</td>
<td>11.78725</td>
<td>-0.2798166</td>
<td>5.810308E-03</td>
</tr>
<tr>
<td>2</td>
<td>70.68134</td>
<td>0.64</td>
<td>11.78944</td>
<td>-0.2797599</td>
<td>5.810308E-03</td>
</tr>
<tr>
<td>3</td>
<td>70.61962</td>
<td>0.256</td>
<td>11.78874</td>
<td>-0.2797441</td>
<td>5.810308E-03</td>
</tr>
<tr>
<td>4</td>
<td>70.58868</td>
<td>0.1024</td>
<td>11.78977</td>
<td>-0.2797041</td>
<td>5.810308E-03</td>
</tr>
<tr>
<td>5</td>
<td>70.58413</td>
<td>0.4096</td>
<td>11.78925</td>
<td>-0.2796919</td>
<td>5.810308E-03</td>
</tr>
<tr>
<td>6</td>
<td>70.5548</td>
<td>0.18384</td>
<td>11.78946</td>
<td>-0.2796662</td>
<td>5.810308E-03</td>
</tr>
<tr>
<td>7</td>
<td>70.54813</td>
<td>0.065536</td>
<td>11.79198</td>
<td>-0.2798135</td>
<td>5.810308E-03</td>
</tr>
<tr>
<td>8</td>
<td>70.51613</td>
<td>0.262144</td>
<td>11.7916</td>
<td>-0.2795997</td>
<td>5.810308E-03</td>
</tr>
<tr>
<td>9</td>
<td>70.50236</td>
<td>0.1048576</td>
<td>11.79268</td>
<td>-0.2795659</td>
<td>5.810308E-03</td>
</tr>
<tr>
<td>10</td>
<td>70.49983</td>
<td>0.4194304</td>
<td>11.79228</td>
<td>-0.279557</td>
<td>5.810308E-03</td>
</tr>
</tbody>
</table>

Maximum iterations before convergence.

This report displays the error (residual) sum of squares, lambda, and parameter estimates for each iteration. It allows you to observe the algorithm’s progress.

## Model Estimation Section

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Parameter Estimate</th>
<th>Asymptotic Standard Error</th>
<th>Lower 95% C.L.</th>
<th>Upper 95% C.L.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0</td>
<td>11.79254</td>
<td>1.012715</td>
<td>9.750206</td>
<td>13.83488</td>
</tr>
<tr>
<td>A1</td>
<td>-0.2795364</td>
<td>9.166186E-02</td>
<td>-0.4643901</td>
<td>-9.468261E-02</td>
</tr>
<tr>
<td>A2</td>
<td>5.810308E-03</td>
<td>9.516727E-03</td>
<td>-1.281847E-03</td>
<td>1.290246E-02</td>
</tr>
<tr>
<td>A3</td>
<td>-1.172031E-05</td>
<td>2.863182E-05</td>
<td>-9.946187E-05</td>
<td>1.602122E-05</td>
</tr>
<tr>
<td>B1</td>
<td>-0.0783304</td>
<td>2.020337E-03</td>
<td>-8.240479E-02</td>
<td>-0.074256</td>
</tr>
<tr>
<td>B2</td>
<td>2.391857E-03</td>
<td>4.689093E-05</td>
<td>2.297292E-03</td>
<td>2.486421E-03</td>
</tr>
<tr>
<td>B3</td>
<td>-2.86472E-05</td>
<td>4.332001E-06</td>
<td>-3.738351E-05</td>
<td>-1.991088E-05</td>
</tr>
<tr>
<td>B4</td>
<td>1.171313E-07</td>
<td>1.025966E-06</td>
<td>-1.951927E-06</td>
<td>2.186189E-06</td>
</tr>
</tbody>
</table>

Dependent Y
Independent X
Model Y=(A0+A1X^1+A2X^2+A3X^3) / (1+B1X^1+B2X^2+B3X^3+B4X^4)
R-Squared 0.990159
Iterations 10
Estimated Model ((11.79254-(-0.2795364)*(X)+(5.810308E-03)*(X)^2-(1.171313E-07)*(X)^3)/(1+(2.391857E-03)*(X)^2-(2.86472E-05)*(X)^3+(1.171313E-07)*(X)^4))

### Parameter Name
The name of the parameter whose results are shown on this line.

### Parameter Estimate
The estimated value of this parameter.

### Asymptotic Standard Error
An estimate of the standard error of the parameter based on asymptotic (large sample) results.

### Lower 95% C.L.
The lower value of a 95% confidence limit for this parameter. This is a large sample (at least 25 observations for each parameter) confidence limit.
Upper 95% C.L.
The upper value of a 95% confidence limit for this parameter. This is a large sample (at least 25 observations for each parameter) confidence limit.

Model
The model that was estimated. Use this to double check that the model estimated was what you wanted.

R-Squared
There is no direct R-Squared defined for nonlinear regression. This is a pseudo R-Squared constructed to approximate the usual R-Squared value used in multiple regression. We use the following generalization of the usual R-Squared formula:

$$R^2 = \frac{\text{ModelSS} - \text{MeanSS}}{\text{TotalSS} - \text{MeanSS}}$$

where MeanSS is the sum of squares due to the mean, ModelSS is the sum of squares due to the model, and TotalSS is the total (uncorrected) sum of squares of Y (the dependent variable).

This version of R-Squared tells you how well the model performs after removing the influence of the mean of Y. Since many nonlinear models do not explicitly include a parameter for the mean of Y, this R-Squared may be negative (in which case we set it to zero) or difficult to interpret. However, if you think of it as a direct extension of the R-Squared that you use in multiple regression, it will serve well for comparative purposes.

Iterations
The number of iterations that were completed before the nonlinear algorithm terminated. If the number of iterations is equal to the Maximum Iterations that you set, the algorithm did not converge, but was aborted.

Estimated Model
The model that was estimated with the parameters replaced with their estimated values. This expression may be copied and pasted as a variable transformation in the spreadsheet. This will allow you to predict for additional values of X.

Analysis of Variance Table

<table>
<thead>
<tr>
<th>Source</th>
<th>DF</th>
<th>Sum of Squares</th>
<th>Mean Square</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean</td>
<td>1</td>
<td>76141.53</td>
<td>76141.53</td>
</tr>
<tr>
<td>Model</td>
<td>8</td>
<td>83234.82</td>
<td>10404.35</td>
</tr>
<tr>
<td>Model (Adjusted)</td>
<td>7</td>
<td>7093.291</td>
<td>1013.327</td>
</tr>
<tr>
<td>Error</td>
<td>43</td>
<td>70.49983</td>
<td>1.639531</td>
</tr>
<tr>
<td>Total (Adjusted)</td>
<td>50</td>
<td>7163.791</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>51</td>
<td>83305.32</td>
<td></td>
</tr>
</tbody>
</table>

Source
The labels of the various sources of variation.

DF
The degrees of freedom.

Sum of Squares
The sum of squares associated with this term. Note that these sums of squares are based on Y, the dependent variable. Individual terms are defined as follows:

Mean
The sum of squares associated with the mean of Y. This may or may not be a part of the model. It is presented since it is the amount used to adjust the other sums of squares.
Ratio of Polynomials Fit – One Variable

**Model**
The sum of squares associated with the model.

**Model (Adjusted)**
The model sum of squares minus the mean sum of squares.

**Error**
The sum of the squared residuals. This is often called the sum of squares error or just “SSE.”

**Total**
The sum of the squared Y values.

**Total (Adjusted)**
The sum of the squared Y values minus the mean sum of squares.

**Mean Square**
The sum of squares divided by the degrees of freedom. The Mean Square for Error is an estimate of the underlying variation in the data.

---

**Asymptotic Correlation Matrix of Parameters**

<table>
<thead>
<tr>
<th>Asymptotic Correlation Matrix of Parameters</th>
<th>A0</th>
<th>A1</th>
<th>A2</th>
<th>A3</th>
<th>B1</th>
<th>B2</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0</td>
<td>1.000000</td>
<td>-0.668342</td>
<td>0.251252</td>
<td>-0.126446</td>
<td>0.045937</td>
<td>0.033491</td>
</tr>
<tr>
<td>A1</td>
<td>-0.668342</td>
<td>1.000000</td>
<td>-0.826039</td>
<td>0.725516</td>
<td>0.586512</td>
<td>-0.664699</td>
</tr>
<tr>
<td>A2</td>
<td>0.251252</td>
<td>-0.826039</td>
<td>1.000000</td>
<td>-0.986996</td>
<td>-0.937223</td>
<td>0.967391</td>
</tr>
<tr>
<td>A3</td>
<td>-0.126446</td>
<td>-0.826039</td>
<td>-0.986996</td>
<td>1.000000</td>
<td>0.978499</td>
<td>-0.991658</td>
</tr>
<tr>
<td>B1</td>
<td>0.045937</td>
<td>0.586512</td>
<td>-0.937223</td>
<td>0.978499</td>
<td>1.000000</td>
<td>-0.989097</td>
</tr>
<tr>
<td>B2</td>
<td>0.033491</td>
<td>-0.664699</td>
<td>0.967391</td>
<td>-0.991658</td>
<td>-0.989097</td>
<td>1.000000</td>
</tr>
<tr>
<td>B3</td>
<td>-0.444426</td>
<td>-0.127711</td>
<td>0.655601</td>
<td>-0.765633</td>
<td>-0.867018</td>
<td>0.801153</td>
</tr>
<tr>
<td>B4</td>
<td>0.769239</td>
<td>-0.364811</td>
<td>0.217490</td>
<td>-0.176658</td>
<td>-0.958111</td>
<td>0.123138</td>
</tr>
</tbody>
</table>

This report displays the asymptotic correlations of the parameter estimates. When these correlations are high (absolute value greater than 0.95), the precision of the parameter estimates is suspect.

---

**Predicted Values and Residuals Section**

<table>
<thead>
<tr>
<th>Predicted Values and Residuals Section</th>
<th>Predicted Value</th>
<th>Lower 95.0% Value</th>
<th>Upper 95.0% Value</th>
<th>Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row No.</td>
<td>X</td>
<td>Y</td>
<td>Value</td>
<td>Value</td>
</tr>
<tr>
<td>1</td>
<td>10.69182</td>
<td>21.76471</td>
<td>23.39933</td>
<td>20.2282</td>
</tr>
<tr>
<td>2</td>
<td>12.26415</td>
<td>26.47059</td>
<td>26.25687</td>
<td>23.30506</td>
</tr>
<tr>
<td>3</td>
<td>13.83648</td>
<td>31.17647</td>
<td>29.50871</td>
<td>26.70471</td>
</tr>
<tr>
<td>4</td>
<td>15.4088</td>
<td>35.88235</td>
<td>33.16126</td>
<td>30.38701</td>
</tr>
</tbody>
</table>

The section shows the values of the residuals and predicted values. If you have observations in which the independent variable is given, but the dependent (Y) variable was left blank, a predicted value and prediction limits will be generated and displayed in this report.
Function Plot(s)

This plot displays the data along with the estimated function and prediction limits. It is useful in deciding if the fit is adequate and the prediction limits are appropriate.

In poorly fit models, we have found that it is often necessary to disable the prediction limits so that the data will show up. In these cases, the prediction limits may be so wide that the scale of the plot does not allow the data values to be separated.

Residual Plot(s)

This is a scatter plot of the residuals versus the independent variable, X. The preferred pattern is a rectangular shape or point cloud. Any nonrandom pattern may require a redefining of the model.
In this example, it appears that the variance of the residuals decreases as X increases—suggesting that the equal variance assumption is violated. If this pattern was very drastic, we might want to try a variance stabilizing transformation of Y or using weighted nonlinear regression. However, the pattern does not appear severe in this case, so we probably would not take further action.

**Probability Plot(s)**

If the residuals are normally distributed, the data points of the normal probability plot will fall along a straight line. Major deviations from this ideal picture reflect departures from normality. Stragglers at either end of the normal probability plot indicate outliers, curvature at both ends of the plot indicates long or short distributional tails, convex or concave curvature indicates a lack of symmetry, and gaps or plateaus or segmentation in the normal probability plot may require a closer examination of the data or model. We do not recommend that you use this diagnostic with small sample sizes.

**Predicting for New Values**

You can use your model to predict Y for new values of X. Here’s how. Add new rows to the bottom of your database containing the values of the independent variable that you want to create predictions for. Leave the dependent variable blank. When the program analyzes your data, it will skip these rows during the estimation phase, but it will generate predicted values for all rows, regardless of whether the Y variable is missing or not.